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Bulk Updates
Bulk update is an efficient way of updating multiple objects in a single operation, and it is available on the
majority of objects in Tree or System Setup that have an editor. A user can also run the bulk update process
on a collection, on a search result, or multiple selected objects.

The Bulk Update wizard guides a user through the process, and ensures all necessary settings and data is
provided to run the update.

Setup Requirements
Setting up and using a bulk update involves the following steps:

1. Determine the method required to start the Bulk Update wizard as described in Creating a Bulk Update.
2. In the wizard, choose a previously saved configuration or create a new one as described in Bulk Update

Configuration.
3. In the wizard, choose one or more operations that will run during the update as described in Bulk Update

Operations.
4. In the wizard, supply the required parameters as described in Bulk Update Parameters.
5. In the wizard, review the expected results of the update as described in Bulk Update Preview.
6. In the wizard, set the required options and run the bulk update as described in Bulk Update Advanced.

Additional Information
The following information is useful once a bulk update is created or run:

1. Monitor a bulk update through a background process as described in Monitoring Bulk Updates.
2. Schedule a bulk update as described in Scheduling Bulk Updates for Collections.
3. Export a bulk update definition as comments and submit to an external source control system for

comparison purposes as described in Configuration Management documentation.
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Creating a Bulk Update
The bulk update functionality allows a user to easily update a large number of objects in a single operation.

To perform a bulk update:

1. Determine the data that should be updated.
2. Use one of the following methods to select data to be updated and launch the Bulk Update wizard.

Run on all objects in a single collection or multiple collections: In Tree, select one or more
collections, right-click and choose Run Bulk Update.

Run on a single or multiple selected objects in Tree or System Setup: Select one or more of the
objects defined in the following table, then from the menu choose File > Bulk Update > Run Bulk
Update.

Note: To run a saved bulk update configuration (which loads the operations and settings) first start the
wizard, and then choose the existing configuration on the Configuration step shown below.

Tree Objects System Setup Objects

Assets
Classifications
Collections
Configurations
eCatalogs
Entities
Index Words
Products
Publication groups
Publication object
sections

Attributes
Attribute Transformations
Asset Importer
Change Packages
Completeness Metrics
Event Processors
Event Queues
Gateway Endpoints
GDSN- Data pool- Receiver
or publisher
Global Business Rules
(actions, conditions, and

List of Values
Match Codes and Matching Algorithms
Outbound Integration Endpoints
Tables
Tags
Units
Users and Groups
Web UIs
Workflows
Workflow Profiles
Reference types / link types
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Tree Objects System Setup Objects

DTP documents in
the publication
hierarchy

libraries)
Inbound Integration
Endpoints
Keys

Object type & structures (asset,
classification, publication, setup group,
etc.)
Context -Dimension points

Run on search results: Perform a search, and click the Bulk Update button ( ).

For more on the Advanced Search tab in workbench, refer to the Advanced Search topic in the Getting
Started documentation.
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3. The Bulk Update wizard displays and can involve the following steps:

Bulk Update Configuration allows you to choose a previously saved configuration or create a new one.
Bulk Update Operations allows you to choose one or more operations that will run during the update.
Bulk Update Parameters allows you to supply any required parameters.
Bulk Update Preview allows you to review the expected results of the update.
Bulk Update Advanced allows you to set the required options and start the background process that
runs the bulk update.
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Bulk Update Configuration
Specify the configuration that should be run for the bulk update.

1. Choose the option for the desired configuration:
Click the 'Use Existing Configuration' radio button to use a saved bulk update configuration, then click
the ellipsis button ( ) to display the configuration selection dialog. Use the Browse or Search tab to
select the relevant configuration and click the Select button.

Click the 'Create New Configuration' radio button to create a new configuration.

2. Click the Next button to display the Bulk Update Operations step.
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Bulk Update Operations
Specify the operations the bulk update should perform on the selected objects. When an existing
configuration is selected, all saved operations are displayed.

1. Add or edit the required operations as follows:
For a new configuration, the default 'Merge Attribute Values' operation is displayed. Select the desired
operation from the dropdown as defined in the individual topics that follow this topic.
Click the 'Add Operation' link to configure an additional operation.
Click the delete button ( ) to remove an operation.
Click the up and down arrow buttons ( ) to change the order of the operations applied to the update.

Important: Ensure that the operations are listed in the order that they need to be performed—from the
top down. This means that when multiple operations are included, those run first can be overwritten by
operations that run later. If one operation fails for an object (for example, due to validation base type
mismatch), all changes to the object will be rolled back and the object will be left as it was prior to
applying the Bulk Update.

2. Click the Next button to display the Bulk Update Parameters step.
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Attribute Values: Clear Value Operation
The Clear Value bulk update plugin allows for clearing values across one or all contexts.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Clear Value (found under 'Attribute values') from the dropdown.

2. For the Attribute parameter, click the ellipsis button ( ) and make an attribute selection using standard
Browse / Search node picker functionality within the Select Attribute dialog.
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3. Click to enable the 'In all contexts' checkbox if you are clearing an attribute value in all contexts. Otherwise,
the values will only be cleared for the context you are currently in.

4. Click Next or Finish to save your selections and complete the Bulk Update wizard setup.

© Stibo Systems - Internal - 2024.4 - December 2024 12



Attribute Values: Merge Attribute Values
Operation
This operation copies the values from the first selected attribute to another selected attribute, in the current
workspace, based on the parameter settings. For dimension dependent attributes, the copy is performed
across all dimensions or applicable combinations of dimensions.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can be started from System Setup by selecting an attribute, then right-click and select Merge
Attribute Values. For details about verifying the attributes before performing this operation, refer to the
Merging Attribute Values section of the System Setup documentation.

This operation can also be run via the business rules functionality, as described in the Business Action: Merge
Attribute Values topic in the Business Rules documentation.

Note: The Merge Attribute Values operation does not delete any attributes, it can only update values. If
desired, manually delete the source attribute once you confirm the merged data.

Prerequisites

Before using this operation:

1. Ensure the source and target attributes are valid for all of the same object types, and for the object on
which the business action will be run.

2. Ensure the source and target attributes are valid for all of the same product links and classification links.
3. Ensure the source and target attributes are valid for all of the same reference types.
4. Ensure the source and target attributes have the same dimension dependencies.

Configuration

1. SelectMerge Attribute Values from the dropdown.

2. For theMerge parameter, click the ellipsis button ( ) to display the Select Attribute dialog, choose the
attribute to copy values from, and click the Select button.
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3. For the into parameter, click the ellipsis button ( ) to display the Select Attribute dialog, choose the
attribute to copy values to, and click the Select button.

4. For the Source Workspace parameter, use the dropdown to select the workspace that holds the values to
be copied. Values are always pasted into the Main workspace.

5. For theOverwrite parameter, use the dropdown to select one of the following options. Validation errors
are displayed when a value cannot be modified. Refer to an illustration of the results in theMerge Results
section below.
Overwrite existing valuesmeans the source value overwrites the target value, except when the
source attribute is blank. If the source attribute is blank, the target value is not changed.
Keep Original valuesmeans the source value is only copied to the target attribute when the target
attribute is blank. If the target attribute contains a value, the target value is not changed.

6. ForMerge Link Attributes, use the dropdown to select one of the following options. If the selected
attributes are both used as an attribute on a reference, a product classification link, or an attribute link,
merging of those values are based on the Yes or No set in this parameter, as well as the other parameters
on the operation. This option is not relevant when values do not exist on references for the selected
attributes.

Merge Results

As indicated in the following table, the source attribute value, target attribute values, and the overwrite setting
together determine the end result of this action.

Source Attribute Value Target Attribute Value Overwrite Setting Target After Merge

<empty> OriginalValue <any> OriginalValue

NewValue <empty> <any> NewValue

NewValue OriginalValue [Overwrite Existing] NewValue

NewValue OriginalValue [Keep Original Values] OriginalValue

Examples

Consider the following example data, and assume that Overwrite existing values is selected (as described
above). Selecting the Source Workspace = Main will result in writing the T-shirt Size value of S, while
selecting Source Workspace = Approved will write the XS value.
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Consider the following data and the effects of the options as shown in the Preview images below. 'T-shirt Size'
is the source attribute and 'Size' is the target attribute:

Notice that the only value changed in this scenario is for object 18212 L B, since the source object had a
value and the target value was blank. Since the other objects either had values for the target or the source
was blank, none of them were modified.

Notice that two values changed in this scenario: object 18210 M B had its value overwritten since a value
existed for the source, and object 18212 L B was overwritten since the source object had a value and the
target value was blank. Objects 18213 M O and 18216 L O both had blank source values, so the target
values were not overwritten.
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Consider the following values for the attributes 'Qty of Next Lower Package' and 'Qty of Next Higher Package'
on the Case to Child reference.

Setting the operation parameters as 'Qty of Next Lower Package' for the source, 'Qty of Next Higher
Package' for the target, using the Overwrite existing values, and setting Merge Link Attribute = Yes results
in this preview of resulting values:

For more information about attributes on references, refer to the Product Attribute Link Type section of the
System Setup documentation.
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Attribute Values: Set Value Operation
Sets the value of the selected attribute based on a value entered manually or via a function.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation is similar to one in the business rules functionality, as described in the Business Action: Set
Attribute Value topic in the Business Rules documentation.

Configuration

1. Select Set Value from the dropdown.
2. For the first parameter, click the manual ( ) button or the function ( ) button and then click the ellipsis

button ( ).

Note: The selected object dictates the label on the manual button. If the selected object requires a text
value, the label is 'abc.' If the selected object is numeric, '123' is displayed, and so on for each
validation base type.

For manual selection, the Select Attribute dialog is displayed, select an attribute, and click Select.

For function selection, click the ellipsis button ( ) displayed near the text field to display the Function
Editor dialog. Add a function and evaluate, the clickOK. Refer to the Using Function Editor topic within
the Resource Materials online help documentation for more information on writing functions.

3. For the second parameter (=), click the manual ( ) button or the function ( ) button.

For manual selection, type the value required for the selected attribute into the text field.
For function selection, click the ellipsis button ( ) displayed near the text field to display the Function
Editor dialog. Add a function and evaluate, the clickOK. Refer to the Using Function Editor topic within
the Resource Materials online help documentation for more information on writing functions.
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Data Containers: Update Data Containers
Operation
This operation is available for Data Containers. For more information on Data Containers, refer to the Data
Containers topic in the System Setup documentation.

This operation allows users to run business actions on selected data container objects. When executing this
operation, users can filter which data container objects to work with by specifying a business condition and/or
data container type, before running the specified business action on those objects.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Update Data Containers from the dropdown.

2. In the Data Container Type parameter, (optional) click the ellipsis button ( ), select the data container
type this operation should apply to, and click Select.

3. In the Business Condition parameter, (optional) click the ellipsis button ( ), select the data container
type this operation should apply to, and click Select.

4. In the Business Action parameter, (required) click the ellipsis button ( ), select the data container type
this operation should apply to, and click Select.
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Data Quality: Generate Match Codes Operation
Use this operation to generate match code values for the selected objects of the bulk update.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action:
Generate Match Codes topic in the Business Rules documentation.

Prerequisites

Before using this operation. ensure match code objects exist as defined in the Match Codes topic of the
Matching, Linking, and Merging documentation.

Configuration

1. SelectGenerate Match Codes from the dropdown.

2. ForMatch Code, click the ellipsis button ( ) to display the Select a Match Code dialog, and the relevant
match code.

Note: Collection objects should match to the match code object type and category.
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Data Quality: Match Duplicates Operation
DEPRECATED. Instead, use 'Send Republish Event' to Event Processor configured to apply matching using
user's matching algorithm, as defined in the Send Republish Event Operation topic.

This operation applies the selected matching algorithm on selected objects for the bulk update. This includes
generating a list of possible duplicates and a score that indicates how identical the objects are. And if a golden
record matching algorithm is used it will also update golden record links and re-apply survivorship rules.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. SelectMatch Duplicates (apply matching algorithm) from the dropdown.

2. For theMatching Algorithm parameter, click the ellipsis button ( ), select the algorithm to use, and
click Select.
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Data Quality: Standardize Address Operation
This operation allows for different standardization actions to be taken on addresses by using the Loqate
solution. If applicable, CASS (Coding Accuracy Support System) operations can also be performed to apply a
stricter level of address validation to US-based addresses.

Standardize Address bulk update operations are valid for execution on entities with flat attributes, e.g.,
Address object types and address Data Containers (Data Containers with address attributes).

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action:
Standardize Address topic in the Business Rules documentation.

Prerequisites

Before a Standardize Address bulk update operation can be run, the following conditions must be met:

Users must be connected to a Loqate server, either through a cloud API or local API.

The Address Component Model must already be configured. It is strongly recommended to configure this
component model using the 'Easy setup of Address Component Model' wizard. For more information, refer
to the Address Component Model section of the Data Integration documentation.

To view and use the CASS features, users must:
Purchase a CASS license
Be connected to Loqate through a local API (CASS components will not work with a Loqate Cloud
API)
Be based in the US, as CASS is not valid outside of the US
Configure the CASS Address Component Model. For more information, refer to the CASS Address
Component Model topic in the Data Integration documentation.

Configuration

This documentation topic describes the options available when configuring a Standardize Address bulk
update operation. For more detailed information on the overall Loqate and CASS solutions, refer to the Loqate
Integration section of the Data Integration documentation.

1. Select Standardize Address from the dropdown.
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2. Make selections for the parameters as defined in the following sections.

Address Standardization Modes Parameter

Three options are available from the Address Standardization Mode dropdown list.

Overwrite Existing Standardized Address:Overwrites an existing standardized address by making a
call to Loqate, which returns the latest standardized address and overwrites the existing one.
Generate Hash Value Only:When this option is chosen, the business action will recalculate the
'Validation Hash' value without making a call to Loqate. The hash value is based on the address input
fields only and is calculated and maintained by STEP.

This option is used in cases when pre-standardized addresses, which are known to be correct, are
imported. Because the addresses are new, no hash value is present. When the 'Generate Hash Value
only' action is run, STEP generates a hash value and places it into the 'Validation Hash' field. The hash
value lets STEP know that the addresses are new, ensuring that they are not picked up and
restandardized by STEP shortly after they are imported. For users of the Loqate Cloud API solution, this
saves money by avoiding unnecessary calls to Loqate, since users are charged a fee for every call made
to Loqate.
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Disable Address Standardization: This option is primarily useful for users who import addresses in bulk,
either manually or by using an inbound integration. If a business rule is in place that runs a Standardize
Address bulk update on import, then selecting 'Disable Address Standardization' is a simple way to
temporarily turn off automatic address validation on import. This allows users to validate the addresses
later.

Renew Address Validations Parameter

The checkbox option Renew address validations older than allows for addresses older than a designated
number of days to be revalidated. This is useful in case an address was validated an extended period of time
ago and the address may no longer be valid. The default number of days is 160. The field is disabled by
entering the value '0.'

STEP determines the age of an address by the value present in the 'Validation Time' field.

Important: For users of the Loqate Cloud installation, care should be exercised when using this
functionality. Since all addresses older than the specified time period will be revalidated, each additional
validation will make a chargeable call to Loqate.
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CASS Validation Parameters

Two CASS address validation options are available on the Standardize Address dialog.

Turn on CASS validation for US addresses: If checked, all addresses are sent for standardization to
the Loqate Local server integration and also validated against CASS data.
CASS Certification Report Event Processor: If you would also like a CASS certification report
generated after using CASS validation on an address, click the ellipsis button ( ) and select the relevant
CASS certification report event processor from the 'Select Event Processor' dialog. For more information,
refer to the CASS Certification Report Processing Plugin Parameters and Triggers section of the System
Setup documentation.
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Merge Golden Records: Merge Clerical Review
Tasks
This operation is available for Merge Golden Records. For more information on a golden records merge
solution, refer to the Match and Merge topic in the Matching, Linking, and Merging documentation.

This operation allows you to merge potential duplicates in a Clerical Review workflow from within the
workbench.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. From the Operations dropdown, selectMerge Golden Records and thenMerge Clerical Review Tasks.

2. Use the dropdowns to select the required configurations.
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STEP Workflow - Select the Clerical Review workflow

Current State - Select that state of the selected Clerical Review workflow
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Merge Golden Records: Purge Source Data
Operation
This operation is available for Merge Golden Records. For more information on a golden records merge
solution, refer to the Match and Merge topic in the Matching, Linking, and Merging documentation.

This operation allows Source Record Data for all sources or per source system to be purged for records with a
current source system / record ID reference to the Golden Records.

Important: Source data is purged for Golden Records that are not in the collection if they are or were
previously associated with the same source records as the Golden Records in the collection. This
consideration applies for Golden Records and Source Records that were part of a merge or unmerge.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. From the Operations dropdown, selectMerge Golden Records and then Purge Source Data.

2. Select an operation radio button:

Purge all (no source system filtering)

Purge source data for specific source systems - also select the desired source systems from the
dropdown.
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Merge Golden Records: Reject Clerical Review
Tasks
This operation is available for Merge Golden Records. For more information on a golden records merge
solution, refer to the Match and Merge topic in the Matching, Linking, and Merging documentation.

This operation allows you to reject potential duplicates in a Clerical Review workflow from within the
workbench.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. From the Operations dropdown, selectMerge Golden Records and then Reject Clerical Review Tasks.

2. Use the dropdowns to select the required configurations.
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STEP Workflow - Select the Clerical Review workflow

Current State - Select that state of the selected Clerical Review workflow
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Publishing: Check Publication Document for
Needs Update Operation
A page will need an update if any elements mounted on the page (for example, attribute values or image
references) have changed in STEP since the page was originally saved to STEP.

This operation checks all actual pages saved to the selected publication / section to determine if updates are
needed.

Checking documents for updates from within STEPWorkbench is primarily useful for Print AutoPage and
Print Flatplanner publications. Since near-identical functionality can be accessed from other locations in the
workbench (including right-clicking on a publication or section object in the Tree and clicking 'Check for
update needed...'), the use cases and applications for checking documents for updates are detailed in the
following publishing-specific topics instead:

Updating Documents in AutoPage in the Publisher (Adobe InDesign Integration) documentation
Updating Documents in Flatplanner in the Publisher (Adobe InDesign Integration) documentation

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Check Publication Document for Needs Update from the dropdown.

2. No parameter configuration is required.
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Publishing: Remove Flatplans from STEP
Workflow Operation
This operation is legacy functionality (pre-STEP 8.0) from when only one workflow at a time was allowed for
planned pages. There is no ability to select a specified workflow.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Remove Flatplans from STEP Workflow from the dropdown.

2. For the Process Note parameter, type a name to be used by the background process.

Note: If only using one Flatplanner workflow, this removes all planned pages from the workflow.
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Publishing: Start Flatplans in STEP Workflow
Operation
This operation adds all Flatplanner spreads (planned pages) in the selected publication group, publication, or
section into the specified Flatplanner workflow. The bulk update is initiated by right-clicking on the desired
publication group, publication, or section. A selection of planned pages can also be chosen for bulk initiation
into a Flatplanner workflow by multi-selecting them and using to File menu, highlight the 'Bulk Update' option
and then select the 'Run Bulk Update' option.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Start Flatplans in STEP Workflow from the dropdown.
2. In theWorkflow parameter, select the desired workflow from the dropdown.

Note: Only workflows valid for planned pages are displayed. Flatplans that are already in a workflow
are not affected.

3. In the Process Note parameter, type a name for the background process.
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Publishing: Update Publication Document
Operation
This option functions almost identically to the Update feature that is directly accessed by right-clicking on
publication, section, or DTP document objects in the Tree. The selections in the 'Operations' dialog pictured
below are identical to those in the 'Update contents of documents' dialog that is accessed through the 'Update'
feature. Because of these similarities—and because the 'Update' feature is more commonly used than the
bulk update feature to update documents—this feature is detailed in the Updating Documents From the
Workbench topic of the Publisher (Adobe InDesign Integration) documentation for more information.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Update Publication Document from the dropdown.

2. Choose one of these options:
Update all contents of section: This updates all information on all actual pages saved to the selected
publication, section, or DTP document.

Update only the following items of the selection: Choosing this allows for the selection of specific
items to be updated on the actual pages, such as attributes, image references, and table types.
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References and Links: Add Attribute Link
Operation
The selected attribute will be linked to the collection of valid objects.

If the attribute is on an object, it can be viewed on the References tab on the object, under the 'Linked
Attributes from Product Hierarchy' flipper.
If the attribute does not have an editable field (or link) to store data, this option adds a link and allows data
to be stored.

For more information on linked attributes refer to the Attribute Links topic in the System Setup documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Add
Attribute Link topic in the Business Rules documentation.

Prerequisites

Before using this operation:

1. Ensure the product attribute link type is set up. For more information, refer to the Product Attribute Link
Type topic in the System Setup documentation.

2. Ensure the selected attribute is valid on the product object type being linked.

Configuration

1. Select Add Attribute Link from the dropdown.

2. In the Attribute parameter, click the ellipsis button ( ) to display the Select Attribute dialog, select a
reference type, and click the Select button.

Example

The following images show before and after the 'BatteryType' Add Attribute Link bulk update is run.
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References and Links: Add Reference or Add
Referenced By Operations
Add Reference and Add Referenced By have similar configurations for bulk updates. Performing the
operation for Add Reference adds a reference of a specified type to a target. Alternatively, the Add
Referenced By operation adds a reference from a target to the source.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Add
Reference topic and the Business Action: Add Referenced By topic in the Business Rules documentation.

Prerequisite

Before using this operation, ensure a valid reference type with the necessary source object exists, and that
the source object is valid for the target object. For more information, refer to the Reference and Link Types
topic in the System Setup documentation.

Configuration

1. Select Add Reference or Add Referenced By from the dropdown.

2. For the Type parameter, click the ellipsis button ( ), select the reference type, and click Select.
3. For the Target or Source parameter, use one of these methods to select the relevant target or source.

Note: The selected object dictates the label on the manual button. If the selected object requires a text
value, the label is 'abc.' If the selected object is numeric, '123' is displayed, and so on for each
validation base type.

For manual selection, click the 'abc' button ( ), click the ellipsis button ( ) to display the Select
Reference Target or Select Reference Source dialog. Select a Target or Source object that is in
accordance with the selected link type, and click Select.
For function selection, click the function button ( ), click the ellipsis button ( ) to display the Function
Editor dialog. Add a function and evaluate, then clickOK. For more information, refer to the Using
Function Editor topic in the Resource Materials online help documentation.
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Examples

An example using Add Reference is below:

Similarly, to specify a function in the function editor, a user can click the ( ) button and then click the ellipsis
button ( ) to display the editor.

Again, an example using Add Reference is below though it works the same way for Add Referenced By:

After selecting the 'Type' of reference, a user opens the function editor and types in the function needed. In
this case there is an attribute on the item called 'Product Image' that holds the ID of an image asset.
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When the bulk update is run, it uses the ID in the attribute to call forth which asset to put on the Primary
Product Image reference.
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References and Links: Automatic Classification
Operation
This operation classifies the selected objects automatically according to a set of rules.

The Automatic Classification functionality is controlled by a component model. For more information, refer to
the Automatic Classification documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action:
Automatic Classification topic in the Business Rules documentation.

Prerequisites

Before using this operation:

1. Ensure the Automatic Classification component is activated.
2. Ensure a rule set configuration for automatic classification exists, as defined in the Initial Setup for

Automatic Classification topic.
3. Ensure the Rule Set object instance in Tree is configured per the component model definition.

Configuration

1. Select Automatic Classification from the dropdown.

2. For the Rule Set parameter, click the ellipsis button ( ), and select the rule set to be executed.

3. For the Use Approved Rule Set parameter, check the checkbox to use the approved version of the rule
set.

4. For the Evaluation Context parameter, select the context where the action should occur.
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References and Links: Industry Classification
Synchronization Operation
This operation allows users to reclassify products when adding an additional version of eCl@ss, ETIM, or
UNSPSC. When executing this operation, products that have an existing link to the source classification will
also get a link to the target classification, using the specified 'Product-to-Classification' link type.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Run a search for any products that need their classification links updated to a newer eCl@ss, ETIM, or
UNSPSC classification hierarchy, and run the bulk update wizard.

2. Select Industry Classification Synchronization from the dropdown.

3. In the Industry standard matcher parameter, select the relevant industry standard from the dropdown
list.

4. In the Source classification root parameter, click the ellipsis button ( ), select the classification root
node for the original industry classification version, and click Select.

5. In the Target classification root parameter, click the ellipsis button ( ), select the classification root
node for the new industry classification version, and click Select.

6. In the Product to classification link type parameter, click the ellipsis button ( ), select the product to
classification link type the products use to link into the classification hierarchy, and click Select.
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References and Links: Link Asset to
Classification Operation
This operation allows users to link assets to a specified classification.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select the assets that need to be linked, and run the bulk update wizard.
2. Select Link Asset to Classification from the dropdown.

3. In the Classification parameter, use one of these methods to select the relevant classification.

Note: The selected object dictates the label on the manual button. If the selected object requires a text
value, the label is 'abc.' If the selected object is numeric, '123' is displayed, and so on for each
validation base type.

For manual selection, click the 'abc' button ( ), and click the ellipsis button ( ) to display the Select
Classification dialog. Select a classification object and click Select.
For function selection, click the 'fx' button ( ), click the ellipsis button ( ) to display the Function
Editor dialog. Add a function and evaluate, then clickOK. For more information, refer to the Using
Function Editor topic in the Resource Materials online help documentation.

Once the bulk update runs, assets appear under designated classification folder.
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References and Links: Remove Attribute Link
Operation
This operation removes the selected link to an attribute when the selected object is linked to the attribute.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action:
Remove Attribute Link topic in the Business Rules documentation.

Prerequisite

Before using this operation, ensure the valid attribute is linked to the product. For more information, refer to
the Product Attribute Link Type topic in the System Setup documentation.

Configuration

1. Select Remove Attribute Link from the dropdown.

2. For the Attribute parameter, click the ellipsis button ( ) to display the Select Attribute dialog, choose the
attribute that should be removed and click the Select button.

Example

The following images show before and after the 'BatteryType' Remove Attribute Link bulk update is run.
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References and Links: Remove Reference
Operation
This operation removes references to a specific target or all references of a specific type.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action:
Remove Reference topic in the Business Rules documentation.

Configuration

1. Select Remove Reference from the dropdown.

2. For the Type parameter, click the ellipsis button ( ) to display the Select Reference Type dialog, choose
the reference type that should be removed and click the Select button.

3. For the Target parameter, use one of these methods to select the relevant target. Leave this parameter
blank to remove all references of a specific type without limiting removal to a node. The target must be in
accordance with the selected type, otherwise an error is displayed.
Click the 'abc' button ( ), click the ellipsis button ( ) to display the Select Reference Target picker,
select a valid target, and click the Select button.
Click the 'fx' button ( ), click the ellipsis button ( ) to display the Function Editor dialog, write a
function to select a valid target, and click the Select button. For more information, refer to the Using
Function Editor topic in the Resource Materials online help documentation.

4. For the Remove all targets parameter, set the checkbox as follows:
Unchecked means references of the specified type are removed from the modified objects.
Checked with a blank Target parameter means all references of the specified type are removed from the
modified objects.
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Example

The 'Product Image' attribute on the item holds the ID of an image asset.

When the bulk update runs, it uses function to determine the value of the attribute, to find which reference to
remove from the Product Image type.
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References and Links: Set Product to
Classification Link Type Operation
This assigns a new object type and a classification link type to the selected classifications.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Set
Product to Classification Link Type topic in the Business Rules documentation.

Prerequisites

1. Ensure a valid Classification Link Type and the Target Classification Object Type exists. For more
information, refer to the Reference and Link Types topic in the System Setup documentation.

2. Ensure a valid classification object type should be linked to the same parent classification of the object
type being changed to.

3. Classification Link Type should have the object type valid.

Configuration

1. Select Set Product to Classification Link Type from the dropdown.

2. In the New Object Type parameter, click the ellipsis button ( ) to display the Select Object Type dialog,
select the classification, and click the Select button.

3. In the New Link Type parameter, click the ellipsis button ( ) to display the Select Product to
Classification Link Type dialog, select the link type, and click the Select button. The target must comply
with the selected type. If the link type does not match the object type selected, an error message displays.

Example

In the following example data, Website1 object type is valid for the 'WebHierarchyRoot', but will be changed to
be valid for 'MerchandisingHierarchyRoot.'
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The items under the WebHierarchyRoot with the Website Link are now going to be of the object type
'Merchandising Hierarchy Root' with the MerchandisingLink type.
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References and Links: Unlink Asset from
Classification Operation
Using this operation, selected assets are unlinked from the specified classification.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Unlink Asset from Classification from the dropdown.

2. For the Classification parameter, use one of these methods to select the relevant classification.

Note: The selected object dictates the label on the manual button. If the selected object requires a text
value, the label is 'abc.' If the selected object is numeric, '123' is displayed, and so on for each
validation base type.

For manual selection, click the 'abc' button ( ), and click the ellipsis button ( ) to display the Select
Classification dialog. Select a classification object where the assets will be unlinked and click Select.
For function selection, click the 'fx' button ( ), click the ellipsis button ( ) to display the Function
Editor dialog. Add a function and evaluate, then clickOK. For more information, refer to the Using
Function Editor topic in the Resource Materials online help documentation.

Examples

Using the setting displayed in the image above, the operation is run on the data shown below. The preview
shows that the IllustrationRoot classification reference will be removed.
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Another example uses the following product and a function to determine the link being removed. The 'Asset
Keywords' attribute on the 'BlueTruckIcon' item holds the ID of the classifications folder. In this case, the
reference to 'BlueTruckIcon' should be removed from the Illustrations classification folder.

The Prodval("Asset Keywords") function is used to remove the classification link by getting the value of the
attribute that holds the ID of the link to be removed.
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Once completed, the asset is no loner linked to the Illustrations classification folder.
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Run Business Rule Operation
This operation runs a business condition and/or action on the selected objects.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Configuration

1. Select Run Business Rule from the dropdown.

2. For the 'Business Rule Condition' parameter, if a condition should be run, click the ellipsis button ( ),
select the condition, and click Select. If the condition evaluates to 'true', the selected business action will
run.

3. For the 'Business Rule Action' parameter, click the ellipsis button ( ), select the action, and click Select.
If the action should always run, no condition should be selected.
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Send Republish Event Operation
This option performs the same operation as selecting 'Republish' on a receiving processor. A republish event
is sent to the event queue of the selected processor for all objects selected for the bulk update.

For more on republishing, refer to the Event-Based OIEP Event Actions topic in the Data Exchange
documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Send
Republish Event topic in the Business Rules documentation.

Prerequisite

Before using this operation, ensure the event queue is enabled and set to Read Events as defined in the
Maintaining Event Queues topic of the Business Rules documentation.

Configuration

1. Select Send Republish Event from the dropdown.

2. For the Receiving Processor parameter, click the ellipsis button ( ) to display the Select Processor for
Events dialog, choose an OIEP or Event Processor that has an event queue, or choose an actual event
queue object. Click the Select button.
This can be an event processor, outbound integration endpoint with an event queue, or an event queue
directly.

Example

For example, in the images below, the 'Item Attribute Change' OIEP is selected as the receiving processor. It
has no events ready to process. Running this bulk update operation adds an event to the OIEP.
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Set Name Operation
This operation sets the name of the object on which the bulk update is run. A user can either enter the name
manually, or specify a function in the Function editor for naming the object.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Set
Name topic in the Business Rules documentation.

Configuration

1. Select Set Name from the dropdown.

2. In the Name parameter, use one of these methods to set the relevant name.
For manual selection, click the 'abc' button ( ), type in a constant value that will be used to update the
name.
For function selection, click the 'fx' button ( ), then click the ellipsis button ( ) to display the Function
Editor dialog. Write a function to set a name and click the Select button. For more information, refer to
the Using Function Editor topic in the Resource Materials online help documentation.

Example

To create a name using the function editor, often attribute values on an item are concatenated. In the image
below, the 'Primary Color' and 'Brand Name' attributes will be combined to create the name of this flashlight.
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Using the Concatenate function, the value from two attributes make a name for this flashlight item.
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Set Object Type Operation
This operation changes the object type of the object on which the bulk update is run. The selected object type
must be valid under the parent of the current object.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Set
Object Type topic in the Business Rules documentation.

Prerequisite

Before using this operation, ensure the objects being modified are valid for the new object type.

Configuration

1. Select Set Object Type from the dropdown.

2. In theObject Type parameter, use one of these methods to set the relevant object type.
For manual selection, click the dropdown to display the available object types in your system. Choose
an item from the dropdown.

When available, you can choose theOther... option to display the Choose Object Type dialog. Then use
the Browse or Search tabs to select an object type and click the Select button.

For function selection, click the 'fx' button ( ), then click the ellipsis button ( ) to display the Function
Editor dialog and write a calculation to select an object type. Click theOK button to save the function.
For more information, refer to the Using Function Editor topic in the Resource Materials online help
documentation.

Example

The example below, 'Attribute C' on the item holds the ID of an object type.
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When the bulk update runs, it uses the value in the attribute to determine the object type.
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Workflow: Claim Operation
Workflow tasks are assigned to user groups where individual users in those groups can then claim the task for
themselves. A user can use the Claim operation to claim a number of tasks at once based on workflow and
state.

For more information on claiming bulk updates in workflows refer to the Bulk Update Operations for Workflows
topic in the Workflows documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action: Claim
topic in the Business Rules documentation.

Configuration

1. Select Claim from the dropdown.

2. For the STEP Workflow parameter, select the relevant workflow from the dropdown.
3. For the Current State parameter, from the dropdown, select from the available states for the workflow.

When the bulk update runs, all tasks in the selected workflow with the selected state are claimed for the
user.
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Workflow: Initiate Items in STEP Workflow
Operation
This operation initiates the bulk update objects into the selected workflow, assuming that the objects selected
are valid for the workflow.

For more information on initiating items in a STEPWorkflow via bulk updates refer to the Bulk Update
Operations for Workflows topic in the Workflows documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Prerequisite

Before using this operation, ensure the workflow exists, and the object is valid for the workflow.

Configuration

1. From the dropdown, select the Workflow group and then select the Initiate Items in STEP Workflow
option.

2. For the Choose a Workflow parameter, select a workflow from the dropdown.
3. For the Process Note parameter, type a note for the background process.
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Workflow: Reassign
This operation allows the user to reassign workflow tasks to another user.

For more on triggering STEPWorkflow events, the Bulk Update Operations for Workflows topic in the
Workflows documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

Prerequisites

Before using this operation:

1. Ensure the workflow exists including states and events.
2. Ensure the node is present in the state defined in the operation.
3. Identify the user or group that will be assigned the tasks.

Configuration

STEP Workflow - From the dropdown select the relevant workflow with tasks to be reassigned.

Current State - From the dropdown select the relevant state. All tasks in the selected state on the
specified workflow will be reassigned to the user or group chosen below.

User/Group - Click the ellipsis button ( ) ) or type an ID to display a list of suggested matches and select
the desired user / user group.

© Stibo Systems - Internal - 2024.4 - December 2024 63



Workflow: Remove Items from STEP Workflow
Operation
This operation removes all objects from one state in a workflow.

For more on how to remove items from STEPWorkflows using bulk updates, refer to the Remove Objects
fromWorkflows topic in the Workflows documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation is similar to one in the business rules functionality, as described in the Business Action:
Remove Object from STEPWorkflow topic in the Business Rules documentation.

Configuration

1. Select Remove Items from STEP Workflow from the dropdown.

2. For the Choose a Workflow parameter, select the workflow from the dropdown.
3. For the Process Note parameter, type a note for the background process.
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Workflow: Trigger STEP Workflow Event
Operation
This operation allows a user to move a task from one state to another state.

For more on triggering STEPWorkflow events, the Bulk Update Operations for Workflows topic in the
Workflows documentation.

For more information on the Bulk Update wizard, refer to the Creating a Bulk Update topic.

This operation can also be run via the business rules functionality, as described in the Business Action:
Trigger STEPWorkflow Event topic in the Business Rules documentation.

Prerequisites

Before using this operation:

1. Ensure the workflow exists including states and events.
2. Ensure the node is present in the state defined in the operation.

Configuration

1. From the dropdown, select the Workflow group and then the Trigger STEP Workflow Event option.

2. In the STEP Workflow parameter, from the dropdown select the relevant workflow.
3. In the Current State parameter, from the dropdown select the state that the workflow object must be in

when the action is applied.
4. In the Event parameter, from the dropdown select the event that the action triggers.
5. In the Process Note parameter, enter a comment to be written in the state log when the event is triggered.
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Bulk Update Parameters
The parameters step is only enabled when the 'Run Business Rule' operation is selected on the Operations
step, and the selected JavaScript business rule includes one or more 'Attribute Validated Parameter' binds.

For more information, refer to the Parameterized Business Actions in Web UI topic in the Web User Interfaces
documentation.

1. If the Parameters step is enabled, supply the necessary data.
2. Click the Next button to display the Bulk Update Preview step.

© Stibo Systems - Internal - 2024.4 - December 2024 66



Bulk Update Preview
This step of the wizard shows some of the results of the configured operations. A maximum of 10 objects are
displayed. For each object, the existing data is shown on the 'Old' row and the data that will result from the
update is shown on the 'New' row.

1. Hover over a warning or error icon to review potential problems with the bulk update

2. Click the Back button to resolve warnings and errors by modifying an operation or parameter.
3. Click the Next button to display Bulk Update Advanced step.
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Bulk Update Advanced
In the final step, select one or more of the available options.

1. Set the following parameters as necessary:

Do not run now runs the bulk update later, and not immediately when the wizard is finished. This
allows a user to save the configuration. When check, the Auto Approve and Pre-flight parameters are
disabled.

Auto Approve approves only updates made by the bulk update and displays them in the approved
workspace when the update succeeds. Only a partial approval is performed.

Note: Auto Approve is not supported when the Run Business Rule Operation is used for the Bulk
Update.

For example, if the bulk update runs on a product attribute and the value is updated, but other changes
have been made to the product that were not done by the bulk update, then the partial approval is
applied only to the bulk-updated value, not to the entire product. However, if the only change(s) on the
product are made by the bulk update, since the bulk update changes are auto approved, the partial
approval actually results in a full approval.

Pre-flight performs a test run of the update. When the user clicks 'Finish', the test runs in a background
process. Selected operations are applied and then rolled back. An execution report and an impact
report is generated. Temporary collections are created for the objects where the operations were
successfully applied, and for the ones were errors were generated. The availability of this option
depends on the user's system setup.
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Important: There is no 'undo functionality for bulk updates. It is recommended to run a Pre-flight
and/or to apply operations to a small set of objects before updating a large number of objects.

Save configuration defines a location and name for the saved configuration so that it can be used
again. Click the ellipsis button ( ) to display the 'Save Operation Configuration' dialog. To name a
new configuration, select a folder and type a name in the Name parameter, and click Create. To
overwrite an existing configuration, select the configuration and click Select.

Process Description displays the name for the background process.

Available for object types limits the object types and nodes affected by the bulk update operations.
First select an object type from the dropdown, then click the ellipsis button ( ) to select the nodes to
update.
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2. Click Finish to complete the bulk update configuration and start the operation(s) in a background process.

3. Monitor the bulk update as defined in the Monitoring Bulk Updates topic.
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Monitoring Bulk Updates
When a user completes the Bulk Update wizard, the Background process status dialog displays. This
allows a user to monitor the status of the bulk update that was created.

Click theGo to Process button to display the BG Processes tab for additional information about the process.

Note: If one operation on an object or the auto approval of the object fails, changes made by other
operations are rolled back, and the object is left as it was prior to the bulk update.

For details on the states of a background process, refer to the BGP States and Quarantine Status topic in the
System Setup documentation.
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When the process has completed, the following options are available in the Bulk Update Actions flipper on
the Background Process tab.

1. Click Save to keep a copy of the execution report. This can be saved locally.
2. Click Truncate if not all lines in the execution report are needed. Upon selecting Truncate, a dialog will

appear allowing users to select which lines to delete, and how many lines to retain.
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3. Click Relaunch Wizard to open the Bulk Update wizard again. The wizard opens with the same objects
selected and with the same operations specified in the process that was just completed.

4. Click Bulk Update OK Objects if a pre-flight process was run the bulk update should now be run on the
objects that were processed without errors.

5. Click Save Failed Objects to save the objects for which the bulk update failed as a new collection. Note
that this option is only available if there were failed objects.

6. Click Impact Report to view a report of the errors that occurred during the bulk update process. This
option is only available if objects failed during the bulk update.
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Scheduling a Task Notification Email
It is possible to send an automated email notifying users of all required workflow tasks by scheduling a bulk
update that uses a business action. This email notification provides users with a single location for all
assigned tasks, and enables users to better prioritize which tasks need to be addressed first.

Prerequisites
All of the configuration steps provided in this topic assume the user has knowledge of configuring collections,
bulk updates, business actions, and workflows.

For more information on collections, refer to the Collections topic in the Getting Started documentation.

For more information on bulk updates, refer to the Bulk Updates topic in the in Bulk Updates documentation.

For more information on business actions, refer to the Business Actions topic in the Business Rules
documentation.

For more information on workflows, refer to Workflows documentation.

Setting Up Email Notifications
To email a user their assigned tasks from a workflow the following elements must be created: a collection, a
business action, and a bulk update. Once configured, an email notification containing a consolidation of all
active tasks from one or more workflows is sent to the user(s) or user group(s) that are assigned the tasks.

To configure these, follow the directions listed below.

1. Create a collection with a single object in it that is permanent. The chosen permanent object needs to be
something that will never be deleted from the system because it will be used in the scheduled bulk update.
Additionally, if more than one object is added to the collection, multiple email notifications could be sent,
which is not the desired outcome. The 'Primary Product Hierarchy' is used in this example.
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2. Create a business action that checks the relevant workflow(s) and their state(s) for tasks. Configure the
business action so that if the desired object types are in the designated workflow state(s), then an email
will be created and sent to the designated user. In this example, the business action is called 'Bulk
Notification.'

To create this business action, under 'Binds,' create variable names to bind to STEP Manager, Query
Home, and Mail Home. In the example, the following binds were created:
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Variable name Bind to

manager STEP Manager

qh Query Home

mh Mail Home

For a full JavaScript code example, refer to the online version of this topic.

3. Create a bulk update configuration that runs the business action just created, as shown in the screenshot
below. Schedule the bulk update to run with the collection that was defined using the business action.

4. Save the Bulk Update configuration.
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5. Navigate to the saved collection created earlier with only one object in it, and click on it. Go up to File >
Bulk Update > Schedule Bulk Update.
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6. Select the bulk update configuration just created and click through the wizard to set the schedule for the
bulk update.
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Since there is only one object in the collection configured on the bulk update, the business action will only
run one single time.

7. When complete, an email is sent to the user listing the tasks they are responsible for in the designated
workflow(s) and their state(s).
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Scheduling Bulk Updates for Collections
Scheduling a bulk update for a collection can be useful when a group of objects needs to be updated on a
regular basis. A scheduled bulk update on a collection can reduce the amount of time required to make those
same updates manually. For example, if products incoming from a specific supplier feature a measurement
with 'millimeters' spelled out, but the internal standard requires only 'mm' to be used, scheduling a bulk update
to make that change periodically can be an effective data management tool.

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed. When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause
confusion about when the job will run since the scheduled time is not automatically converted to
accommodate potential differences in time zones.

Prerequisites
The following tasks must be completed before a collection is scheduled to run a bulk update.

1. Create a collection. More on creating a collection can be found in the Creating Collections topic in the
Getting Started documentation.

2. Create a bulk update configuration. Refer to Creating a Bulk Update topic for more on how to configure a
bulk update.

Scheduling Bulk Updates
To perform a bulk update on a collection at regular intervals, create a schedule that applies to a particular
collection. The bulk update is then automatically run at the scheduled time.

1. Open the Schedule Bulk Update wizard from File > Bulk Updates > Schedule Bulk Update.

2. On Setup, for the Collection parameter, click the ellipsis button ( ) to locate and select the relevant
collection. This option is not valid if the collection is created from the File menu, Bulk Update option, Run
Bulk Update.
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For the Refresh before each run (Search Collections only) parameter, if the collection selected was
created using the search criteria, and the checkbox is selected, it will refresh the collection based on the
current data using search criteria, before executing the bulk update operation(s).

3. For the Configuration parameter, click the ellipsis button ( ) to locate and select the relevant
configuration.
For the Auto approve changes parameter, check the checkbox to place the updated objects in the
approved workspace immediately after the update.

4. Click Next to display Preview and review the example results of the update.
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5. Click Next to display Schedule Process and create the time schedule by selecting either Now, Later,
Weekly,Monthly, or Later and repeat. Complete the options related to the schedule.

6. Click Next to display Name Process and enter a name for the Schedule Process Name parameter. The
Process Name parameter displays the name displayed in the Background Processes tab.
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7. Click Finish to complete the wizard.
8. On the Background Processes dialog choose an option:

ClickGo to process to display the background process.
Click Close to display the workbench.

Below, on the BG Processes tab, viewing the process shows a bulk update that is scheduled to run at a later
time under 'Queued processes.'

For details on the states of a background process, Refer to the BGP States and Quarantine Status topic in the
System Setup documentation.
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Below, on the BG Processes tab, the Execution Report shows the process with a Status of 'waiting.' If users
need to make an adjustment to the scheduled bulk update, clicking the 'Edit Schedule' button (shown at the
bottom of the screenshot below) will reopen the 'Schedule Bulk Update' wizard on the 'Schedule Process'
step. Users can then amend the schedule as needed, and the changes will be applied to the bulk update.

For information on how to schedule bulk updates for collections in Web UI, refer to the Scheduling a Collection
Refresh in Web UI topic.

© Stibo Systems - Internal - 2024.4 - December 2024 85



Scheduling a Collection Refresh in Web UI
Collections are often used as filters on status selectors, though to refresh a collection in the Web UI you must
go to the collection directly to refresh it in Web UI without going to the collection directly. This can be
accomplished by going to the collection content screen directly or via a scheduled bulk update. Using a
scheduled bulk update you can control the amount and frequency of the collection refresh processes.

For more information on status selectors, refer to the Status Selector HomepageWidget topic in the Web
User Interfaces documentation.

Important: Consider the time zone of the application server compared to that of the workbench (the client)
where the schedule is created or viewed. When scheduling a job, the local time zone is displayed in the
workbench, but the time zone of the server is used to run the background process. Although displayed, the
time zone of the client is not included in the instruction to the server to run the job. This can cause
confusion about when the job will run since the scheduled time is not automatically converted to
accommodate potential differences in time zones.

To schedule a collection refresh, follow the directions below:

1. Create a new bulk update configuration. In the example below, a collection is created by right-clicking on
the desired collection in workbench and selecting Run Bulk Update.

2. In the Bulk Update dialog, select Create New Configuration, and click Next.

© Stibo Systems - Internal - 2024.4 - December 2024 86



3. In the Operations step, close the default operation template to remove all operations. This will enable the
action buttons so that you can proceed with no operation selected.
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4. Continue to click Next to get to the final step, and be sure to select Save Configuration before finishing.
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Once complete, this will trigger the update, but it does not actually execute any changes. You may view
the background process, or close the dialog prompt.

5. Next, navigate to File > Bulk Update > Schedule Bulk Update.

6. Select the relevant collection, check the refresh option, and select the bulk update configuration that you
just created in the previous steps.
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7. Continue to click Next to get to the Schedule Process step. Select the Later and repeat option, and
specify the interval at which it should be run.

8. Click Next / Finish to complete the 'Schedule Bulk Update' process.
9. Repeat steps 5-8 as needed to schedule auto-refreshes for additional collections.
If the schedule for the Bulk Update must be amended, users can click on the scheduled bulk update on the
BGProcesses tab, and then click the 'Edit Schedule' button (shown at the bottom of the screenshot below).
This will reopen the 'Schedule Bulk Update' wizard on the 'Schedule Process' step from which users can then
amend the schedule as needed. The changes will be applied to the scheduled bulk update.
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